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Lesson 1: Introducing Excel 

Lesson Objectives 
In this lesson, you will be introduced to the Excel application, learn how it works, and understand how to move 
around within the application. You will also learn to create a workbook, enter data into a worksheet, and work 
with files. Upon completion of this lesson, you should be able to: 

 Explain what an electronic spreadsheet is. 

 Understand what Excel is and what it can do. 

 Identify elements on the Excel screen. 

 Understand some basic terminology. 

 Move around within Excel. 

 Use keyboard shortcuts. 

 Enter text, numbers, dates, and times. 

 Move around within a worksheet. 

 Use the Backstage view to save, create new, 
open, and close workbooks. 

 Switch among open workbooks. 

 Save in a previous version Excel format, and 
check for compatibility issues. 

 Manage files and folders. 

 Select cells. 

What is Excel? 
Excel is an electronic spreadsheet program developed by Microsoft, originally for the Windows environment, 
but is now available for the Apple Mac or any computer with a web browser. A powerful tool for analyzing 
and presenting information, Excel consists of three programs in one: 
Spreadsheet – Entering and analyzing numeric data in applications such as financial forecasting and 
statistical problems. Excel performs math calculations so quickly that they appear to be simultaneous. Excel 
uses the term worksheet in place of spreadsheet. 
Graphics – Creating charts to represent numeric data. 
Database – Compiling and sorting lists of data. 
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Some of Excel’s advantages are: 
• It is relatively easy to learn. All Microsoft Office Suite programs, such as Word, Excel, and PowerPoint, 

operate similarly. Many of the skills you learn in one program carry over to others. 
• It enables data to be exchanged easily between the different Office programs. For example, you can 

create a chart in Excel and insert it into a document you are writing using Word. 
• Excel can produce output of print-shop quality using features such as the spelling checker and other 

tools that enhance your work and provide it with a professional look. 
• Excel has a large selection of mathematical, financial, statistical, and database functions. It includes 14 

basic chart types and each of the commonly-used chart types have four or more subtypes. There are also 
some tools for forecasting or analysis, and a function helper. 

• Worksheets can be grouped together in a single file rather than separate files. In Excel, these files are 
called workbooks. Inside a workbook, there are several ways to manage the multiple worksheets such as 
renaming worksheet tabs. 

• Excel uses AutoFill to fill selected cells with data that follows from the information in the first of the 
selected cells. For example, if you select four cells, and the first cell contains Qtr 1, AutoFill will fill in the 
next three cells with Qtr 2, Qtr 3, and Qtr 4. 

• By default, edits occur directly in the cell. This includes formatting portions of text and making font 
changes. Alternatively, you can perform edits in the Formula bar. 

Although Excel is a very large program, it is enjoyable to learn and use. Most people find it takes them less 
time to become competent and productive with Excel than they initially anticipated. For the purpose of this 
courseware, we will assume that you are using Excel on a Windows computer.  

Starting Excel  
In Windows 10, there are a couple of ways to start the Excel program: 

• If it is present in the Start window, click or tap the Windows 
Start button, then select the Excel tile from the Start window.  

 
• Click the Windows Start button, scroll through the apps, and 

then click Excel.  
• In the taskbar, click or tap the Excel Quick Launch icon. 

 

Looking at the Screen  
When Excel starts, the startup screen (Figure 1-1) appears from which you can open a workbook, start a new 
blank workbook, or create a new workbook based on a template.  
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Figure 1-1: Excel startup screen 

To create a new workbook, click Blank workbook. A new workbook opens and the screen displays as shown 
in Figure 1-2. 

 
Figure 1-2: Excel application window – new workbook 



Lesson 1 Introducing Excel 
 

4  3273-1 v1.00 © CCI Learning Solutions Inc. 

File Tab – Click this tab to open the Backstage view from which you can select commands to manage files, 
such as Info, New, Open, Save, Print, Export or Options. When the Info screen is displayed in Backstage view, 
the right side of the page displays options you can choose to control your workbook including protect, 
inspect, and manage. File properties are also displayed here.   

Quick Access Toolbar – Located above the Ribbon, this provides quick access to frequently used commands. 
You can customize the toolbar to contain commands you use regularly. 

Title Bar – Located at the top of the screen, the title bar indicates the contents of the window (for example, 
Book1, Department Budget). It may also show the text [Compatibility Mode] if the workbook you are using 
has been saved to be compatible with a previous version of Excel. If more than one window is open on the 
screen, the one with a title bar that has a darker color or intensity is the active window. 

Minimize, Maximize, Restore Down, Close  – Located in the upper right-hand corner of the window, these 
buttons enable you to minimize ( ) the application window to a button on the taskbar, maximize ( ) the 
program to full screen, restore ( ) the window to its original size, or close ( ) the application window.  

Ribbon – A collection of tabs (for example, File, Home, Insert, Draw, Page Layout) provides quick access to 
commands you need to complete a task. You can control which tabs display on the Ribbon, and your screen 
may contain fewer or more tabs than those shown in Figure 1-2. Each Ribbon tab relates to a type of activity 
such as inserting objects in a worksheet or modifying the format of data in a worksheet. In Figure 1-2, the 
Home tab is currently selected, and all the icons and options for that Ribbon tab are displayed.  

Ribbon Group – Each Ribbon tab contains groups of related commands to edit, format, or enhance items in 
your documents. Some groups include a dialog box launcher button at the bottom right, which opens a 
dialog box or window with more commands and options. 
Ribbon Display Options – Controls whether to hide or display the Ribbon with the tabs or with both tabs 
and command buttons.  
Name Box – Located on the left below the Ribbon, this displays the cell address of the active cell. For 
example, if the Name Box displays A21, this indicates that A21 (the cell at the intersection of column A and 
row 21) is the active cell. In Figure 1-2, three cells are selected. Cell B6 is the upper left-most cell of that cell 
range and therefore its cell address is displayed in the Name Box to designate it as the active cell.  
Insert Function – This tool opens a dialog box to help you choose and insert a built-in function.  
Formula Bar – Located to the right of the Name Box, the Formula Bar displays the contents of the active 
cell. Under certain circumstances, the Formula Bar can be used to make entries into the worksheet.  
Tell Me – This allows you to enter a description of what you are looking for. Unlike the simpler help feature 
in older versions of Excel, the Tell Me feature will display a customized menu of the commands that you are 
looking for.  
Column Headings – Sequential letters at the top of each column enable you to track columns. 
Active Cell – The cell on which the cell pointer is positioned. You enter text or other values into the active 
cell in the worksheet. Only one cell can be the active cell at any given time.  
Row Headings – Sequential numbers on the left side of each row enable you to track rows. 
Sheet Tab – The rectangular box at the bottom of a worksheet by which the worksheet is accessed and 
identified. Each workbook contains one or more worksheets, and each worksheet has a unique name that 
appears on the worksheet tab. 
Status Bar – Displays the current cell mode, auto calculations, the View buttons, and the Zoom slider. You 
can customize the Status bar to display keyboard locks and other features. 
View Buttons – These buttons change the on-screen views for the worksheet. The views are Normal, Page 
Layout, and Page Break Preview. 
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Learn to use the Ribbon 
In this exercise, you will start Excel and access some of the tools to see how they work. 

1. Launch Microsoft Excel.  

The Excel startup screen appears. From here, you can choose to open a workbook or create a new one 
using a workbook template. 

2. Click Blank workbook to create a new workbook. 

Now access the Backstage. The Office Backstage is used to perform the file management functions such as 
printing, sharing, exporting, or changing Excel options. 

3. Click File to access the Backstage. 

4. Click the  Back button to return to the workbook. 

5. Use the mouse pointer to point to the View tab. 

Notice how the View tab displays in darker text and is highlighted, even though you have not clicked it. 

6. Click the View tab to activate it. 

Notice that the name of the tab appears in bold and that a green line displays below the tab name, 
indicating it is the current tab. 

7. On the View tab, in the Workbook Views group, point to Page Layout. 

Notice how the color of the button changes. 

8. Click Page Layout to change the view. 

9. On the View tab, in the Workbook Views group, click Normal to switch back to the default view. 

10. Press P to display the Page Layout tab. 

11. Then press M to display the Margins options. 

Entering Data in a Worksheet 
If you design and build it in a logical manner, an Excel worksheet is a very powerful tool. The basic building 
block of every worksheet is entering data into the cells. 

Types of Data 
You can make three main types of entries when you insert data into worksheet cells: 

Numeric – Numeric data form the core of all worksheets. This type of data consists of number, date, or time 
values that you enter directly into a worksheet cell. By default, numeric values align to the right in a cell. 

Text – Text data consist of alphabetic and numeric characters and most printable symbols. Text data are 
usually labels or titles used to describe and explain the data in adjoining cells. Text is seldom included in 
calculations, but Excel does include several functions that apply to text data. If you enter a text value that is 
wider than the cell, it will flow into the adjacent cells as long as those cells are empty. By default, text data 
align to the left in a cell. 
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Formulas – Formulas, which you enter in individual cells, are composed of values, cell references, arithmetic 
operators, and special functions for calculating and displaying results. These results may then become part 
of other formulas located in other cells. The ability to use formulas is what differentiates spreadsheets from 
word processing software like Microsoft Word.  

Entering Text 
To enter data, move your pointer to the desired cell, click in it to position the cell pointer, and type the entry. 
If you make a typing error while still entering information in a cell, press the BACKSPACE key to erase your 
mistake. When you have finished entering data in a cell, press the ENTER key to move the cell pointer 
automatically to the next cell down. Alternatively, use your mouse to click another cell (or press any arrow 
key), which performs the same result of storing the data in that cell and moving the cell pointer to the new 
location. 

The best way to begin any worksheet is to enter column and row titles that identify the purpose of the 
numeric data. When you enter titles for the worksheet, you are creating an outline of the relationships you 
will later represent mathematically. 

When typing information, notice that Excel displays the text in two places: 
• You can enter or edit data directly in the active cell where the cell pointer appears, or you can enter or 

edit it in the Formula bar. The latter method is especially useful for very long data entries. In either case, 
the data is displayed in both places. 

• Text entries can be up to 32,767 characters, although a maximum of 255 characters are displayed. If a 
text entry is longer than the width of the cell, it will extend past the column border on the right after you 
have pressed ENTER, as long as there is nothing entered in those adjoining cells. Any value entered into 
the cell on the immediate right will truncate the display of the text at the border. For long entries, the 
entire text value will be stored in the cell, but only the portion that fits in the available space is visible. 
By default, Excel aligns text data on the left side of the cell. You can easily change the appearance and 
alignment of a text entry. 

Learn to enter text data 
In this exercise, you will enter text into a worksheet. The text will serve as labels or titles for other cells into 
which you later enter numeric data. 

1. In the blank workbook from the previous exercise, click in cell A2. 

2. Type: Price Quote and press ENTER. 

Notice the current active cell is now A3. When you press ENTER, Excel completes the entry of data in the 
current cell, then moves the cell pointer to the next cell down. 

3. Press ENTER twice to move down two rows. 

4. In cell A5, type: Airfare and press ENTER. 

5. In cell A6, type: Hotel and press ENTER. 

6. In cell A7, type: Car Rental and press ENTER. 

7. In cell A8, type: Taxes and press ENTER. 
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Note: If you entered the wrong value into a cell, simply select the cell and type the entire correct entry 
again to replace the incorrect value. 

Now try a feature called AutoComplete, in which Excel determines whether you are repeating the same text 
as in a previous cell and completes it for you. If it is the text you want, you simply press ENTER to accept it. 

8. In cell A9, type: A. 

 
Notice that Excel automatically offers you a text label, based on your previous entry. You can now press 
ENTER to accept it or continue typing the value that you want.  

9. Ignore the suggested label and continue typing the rest of the text: irport Fees and press ENTER. 

Notice that the text extends further than the default column width for this text entry. If you enter data in 
the next column, the part of this new label that overflows into the next column will appear to be cut off. 

10. In cell A12, type: Airline: and press ENTER. 

Notice this time that the AutoComplete feature did not turn on. This is because of the blank cells (A10 
and A11) that are preventing Excel from “looking up” a previous similar value in this column. 

11. Enter the following in the remaining cells: 

Cell Text 
A13 Hotel: 
B12 Great West Airline 
B13 Hotel Zathura 

 

12. Leave the workbook open for the next exercise. 

Entering Numbers 
Numbers, such as those representing dollar and percentage values, are constant – that is, they do not change. 
They are typically used as part of calculations, with results appearing in other parts of the workbook.  

By default, Excel aligns numeric values to the right side of a cell. They are displayed with no commas unless 
you enter them at the same time. Extraneous zeroes at the far left or right are not displayed, even if entered 
at the same time. You can format the values to your preference at a later time. 

If you enter a value that contains a mixture of alphabetic and numeric digits (for example, T-1000), Excel 
treats the entire entry as text and aligns it to the left of the cell.  
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Learn to enter numeric data 
In this exercise you will enter numeric data into a worksheet.  

1. In the unsaved workbook from the previous exercise, click in cell B5, type: 450 and press ENTER. 

2. In cell B6, type: 1,050 and press ENTER. 

3. In cell B7, type: 225 and press ENTER. 

4. In cell B8, type: 46.50 and press ENTER. 

5. In cell B9, type: 9.9 and press ENTER. 

6. Click in cell A9. 

Notice in cell A9 that the part of the text entry that had overflowed into cell B9 is now hidden because 
you entered a value into cell B9. However, the formula bar shows that the data in cell A9 is unchanged. 

7. Click in cell D8, and type: 3.1% and press ENTER. 

Excel interprets the entered values as numeric and aligns them on the right of their cells. However, if you 
enter any non-recognizable characters, or insert any commas or decimal points in the wrong position, 
Excel will treat the entire contents of that cell as a label and align it on the left side of the cell. 

Working with Workbooks 
As you begin using workbooks, you need to consider how to organize your files for quick and easy access. 
This includes considerations such as how you name the file, where you save it, whether it needs to be saved 
as a specific file type, and whether you want to add or change the file properties to make it easier to find 
later. The Save commands are located in the Backstage view, which you access via the File tab. 

Saving Workbooks 
To be able to recall your work later, you must save your workbook before exiting Excel or turning off your 
computer. The saved file also provides an excellent fallback option if you try something in your worksheet 
that does not work as you expected, and you are unable or unwilling to undertake all the necessary steps to 
correct the problem.  

When naming a workbook, keep the following in mind: 

• Workbook names must follow the same basic rules as naming files in Windows: a maximum of 255 
characters (including the drive and folder path), and none of these characters: / \ : * ? “ < >|  

• File names should be descriptive so that you can identify the contents quickly. 

• Excel automatically assigns a .xlsx extension or file type at the end of the file name, so you need not do 
this. You only have to type in the name for the workbook. 

• Files can be saved with two different types of save commands: 

– Use Save to save changes to the active workbook but retain the existing name and keep the file in 
the existing location. 

– Use Save As to save a new document or to save an existing document with a new name or new 
location.  
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– When the file name appears in the Save As dialog box (Figure 1-10) as highlighted text, begin typing 
the new file name to insert the new file name for this workbook. Use the arrow direction keys to 
move anywhere in the existing file name to add or delete text to the file name. 

  
Figure 1-10: Save As dialog box  

Learn to save workbooks 
In this exercise, you will save the new workbook you have been creating. 

1. In the unsaved workbook from the previous exercise, in the Quick Access Toolbar, click Save. 

You are taken to Backstage view, and the Save As page is displayed. Even though you clicked Save, Excel 
will automatically skip to Save As for any new workbook that has not yet been saved. The Save As 
command allows you to assign the workbook a name and storage location. 

2. Click the Browse button to open the Save As dialog box. 

3. Navigate to the 3273 Exercise Files\MyProjects folder. 

Notice that Excel enters the current title of the workbook as a suggestion for the file name. You can use 
this name or replace it with a name of your choosing. 

Whenever text is highlighted in a box, you can begin typing to replace existing text rather than deleting the 
characters first and then typing in the new name. 

4. Click in the File name field, select the text if necessary, and type: My Price Quote 0630. 

Creating a New Workbook 
While you are using a workbook, you can also create a new workbook at any time. You can have more than 
one workbook open and on the screen at any time. Each workbook is created in its own window, and each 
window can only have one workbook. Also, each workbook window can be placed anywhere on the Desktop, 
independent of any other workbook window that is open at the same time.  

Each time you create a new blank workbook in a current session, Excel numbers it sequentially, starting at 1 
as Book#, with # representing the number of new workbooks you have created up to that moment. The 
document numbering will begin at 1 again when you start a new session of Excel. 
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To create a new blank workbook, use one of the following methods: 
• to create a new blank document, click File, click New, then click Blank workbook, or 
• press CTRL+N. 

Instead of starting with a blank workbook, you can create a workbook using a template. A template is simply 
a pre-designed workbook that may already contain data, formulas, and other objects, which saves you time 
and effort. Examples of common templates are sales invoices, balance sheets, and loan amortization 
schedules. Whenever you use the New option to create a new workbook, you will be presented with many 
pre-made templates (in addition to the blank workbook) that you can begin using immediately. You can also 
search for additional templates online from the Microsoft Office.com website using the search text box at 
the top of the window. In reality, all of these templates are downloaded from the Microsoft Office website. 
The New page (shown in Figure 1-11) simply displays some examples that may be of interest to you. 

Learn to create new workbooks 
In this exercise, you will create new workbooks. 

1. With the My Price Quote 0630 workbook open, press CTRL+N. 

You should now have a new blank workbook titled as Book2 on the screen, appearing in front of the My 
Price Quote 0630 workbook. 

2. If the Excel window is maximized to the full screen, click the  (Restore Down) button to change it to 
a window. 

Two workbooks are now visible on your screen. 

3. Click File to display the Office Backstage and then click New in the panel at the left to access the New 
page in Backstage view. 

 In addition to the Blank workbook option, several other workbook templates are also readily available. 

Note: If you do not have access to templates on the Microsoft Office website, you will not be able to 
complete Steps 4 and 5 in this exercise; create another new blank workbook instead and skip to Step 6. 

4. Scroll down the screen and click one of the available templates. The preview window appears showing 
an image of the template and a brief description.  

5. Click Create. 

Notice that many elements are created automatically. This demonstrates how using a template can save 
you time and effort when creating a workbook. 

6. Save your new workbook with the name My Workbook in the 3273 Exercise Files\MyProjects folder. 

Opening a Workbook 
If you want to work with a previously created and saved workbook, you must first open it. You can open as 
many workbooks as needed. The only limitation is the amount of memory available on your system to handle 
multiple workbooks. 
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If you do not recall the name or location of the Excel workbook, use the File Explorer to try to find the 
workbook on the computer or on the network. Alternatively, Excel displays a list of the most recently opened 
workbooks, which you can use if you know that the workbook was recently used on the computer you are 
using.  

Use one of the following methods to open a workbook: 

• if Excel is starting up, click the desired workbook in the Recent section of the Excel startup screen or click 
More workbooks, or 

• right-click the Excel Quick Launch icon in the taskbar and select the recently used workbook from the 
Recent list, or  

• with a workbook currently open, click File, click Open, and then click the file from the list of recently used 
workbooks (Figure 1-13), or 

Closing a Workbook 
Once you have finished creating or updating a workbook, close it to clear the screen and free up computer 
memory. This ensures that any unsaved data for that workbook is saved onto the hard drive, and protects 
the workbook from unintended changes. Closing your workbook is much like closing a book and putting it 
back on the shelf before opening another book. 

You can use one of the following methods to close a workbook: 
• click File and then Close, or 
• press CTRL+W or CTRL+F4, or 
• click the  Close button.  

Working with the Compatibility Mode 
Objective 1.5.4 

Excel 2007 and later versions all use the same file format for saved workbooks, which have the extension .xlsx 
at the end of the file name. If you have a user who is using Excel 97, 2000, 2002, or 2003, then you must save 
your workbook as a new and different file using the older format to enable them to open it. These workbooks 
use the file extension of .xls. To save a workbook in this format, click File, click Save As, and then click the 
Save as type arrow and select Excel 97-2003 Workbook.  

All versions of Excel released after 2007 are able to open any files saved in the 97-2003 format. They can also 
make changes to the older file type's contents and save the workbook in the older format. Excel will inform 
you that the workbook is using an older format by displaying the words “Compatibility Mode” next to the 
workbook name in the title bar.  

Selecting Cells 
The ability to select a range of cells is a fundamental skill in Excel. Prior to issuing a command or undertaking 
a procedure, you must indicate what part of the worksheet you wish to affect with the command. Range 
selection is the means to indicate this area. 

A range selection can be as small as a single cell, or as large as the entire spreadsheet. Excel keeps the cell(s) 
highlighted until you change or remove the selection. Clicking a cell or using an arrow key will remove the 
selection. 
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In a worksheet, you can select: 

• a single cell, that is, the active cell 

• a single range, for example, a rectangular section of a worksheet containing two or more cells 

• multiple ranges of cells 

Excel displays the selected range by reversing the color of the cells. Within the selected range, one cell 
appears in a normal color. This is the active cell of the range. 

Learn to select cell ranges 
In this exercise, you will select ranges of cells using the mouse in a blank worksheet. 

1. Create a new blank workbook. 

2. Select a single cell by clicking cell A9. 

3. Select a range of cells by holding the left mouse button down in cell A9, dragging the mouse to cell C5, 
and then releasing the mouse button. 

Now try selecting another range of cells using an alternate method with the keyboard. 

4. Select cell E10. 

5. Press and hold SHIFT, then click cell G15. 

6. Close the workbook without saving. 

Lesson Summary 
Now that you have completed this lesson, you should be able to: 

 Explain what an electronic spreadsheet is.  

 Understand what Excel is and what it can do. 

 Identify elements on the Excel screen. 

 Understand some basic terminology. 

 Move around within Excel. 

 Use keyboard shortcuts. 

 Enter text, numbers, dates, and times. 

 Move around within a worksheet. 

 Use the Backstage view to save, create new, 
open, and close workbooks. 

 Switch among open workbooks. 

 Save in a previous version Excel format, and 
check for compatibility issues. 

 Mange files and folders. 

 Select cells. 

Key Terms 
Term Definition 

Active cell The currently selected cell. 

Backstage A view that allows you to manage the workbook, including printing, opening and 
saving in different formats, and changing the metadata. 
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Quiz Questions  
For each question, select the best answer. 

1. You should use an electronic spreadsheet if you want to: 

a. Create a presentation for viewing at a kiosk. 
b. Perform a large number of mathematical calculations and display charts and graphs. 
c. Track extremely complex data relationships. 
d. Create and print a full-color brochure for investment brokers. 

2. What is the difference between a workbook and a worksheet? 

a. A worksheet is a document created in Access, while a workbook is created in Excel. 
b. A worksheet can contain numbers, text and formulas, whereas a workbook can contain only 

numbers. 
c. A worksheet is a document divided into columns and rows, whereas a workbook is a single Excel file 

containing one or more worksheets. 
d. A worksheet contains data for viewing onscreen only, whereas a workbook can be printed. 

3. If you want to access the Ribbon using the keyboard, you should: 

a. Press the Alt or F10 key. 
b. Turn on Excel’s built-in accessibility features. 
c. Press CTRL+ALT+DEL. 
d. Press the WINDOWS key. 
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